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(1) Introduction

The EAMS (Erosion Assessment and Modelling System) software is designed for the rapid

assessment of erosion on disturbed sites. In particular it is designed predict erosion many years

in future after the landform has changed its shape in response to the erosion that has occurred on

it. It does by integrating a widely known landform evolution model, SIBERIA, with data input

and manipulation software, an erosion database, and data visualisation software with lite-GIS

capabilities.

The EAMS suite consists of two main packages. The first component is EAMS-

MOSCOW (simply referred to as Moscow below) which does the erosion modelling. Moscow

essentially sets up all the commands that SIBERIA uses when it runs (thus its name). The

second component is EAMS-Viewer (simply referred to as Viewer below) which is used for

data visualisation and provides a simple GIS capability to assist in setting up files for the more

advanced capabilities of SIBERIA (e.g. spatial variation of erosion and runoff properties). In

both cases the software is capable of handling extremely large data sets (e.g. the software has

been run with datasets of more 500,000 data points).

Broadly Moscow does:

• Data conversion of files containing irregular points of elevation in DXF (i.e. AutoCAD),

XYZ (i.e. triples of x,y,z, coordinates) and MINDRAFT (i.e. RAW) formats into the

internal format of EAMS.

• Gridding of this data and automatic correction of artefacts that are generated in the gridding.

• Selection and manipulation of erosion, runoff, geology and other parameters from a

database of parameters. Assess to the advanced capabilities of SIBERIA (e.g. spatial,

temporal and/or depth varying runoff and erosion properties) through the input of command

files that control these capabilities.

• Running of SIBERIA with output of landform elevations, slopes, gully locations and other

indicators of erosion/deposition at various (user-controlled) times during the design lifetime

requested. Additionally, as an option, output of spatially distributed estimates of

instantaneous and cumulative erosion over the design lifetime, as well as indicators of gully

erosion can be output. For a full compendium of SIBERIA’s capabilities the user should

refer to the SIBERIA manual provided with the EAMS software.

Broadly Viewer does:

• Visualisation of SIBERIA output in 2D (i.e. plan view), 3D (i.e. a lit surface) and draped

(i.e. output data projected onto the 3D landform) format.

• A flexible and powerful means of selection of parts of the landform (called regions), and

saving those regions so that they may be able to be used in SIBERIA to control the spatial

variability capabilities of SIBERIA.

• Virtual Earthworks. This provides tools for manipulation of the landform so that problems

arising from the design of the landform (e.g. poor erosion performance in parts of the
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landform) can be easily corrected. Output of this redesigned landform back to Moscow for

revised erosion assessment.

Hardware requirements

Minimal Requirements: EAMS will run on Windows 95 or later with at least 128 megabytes of

memory with a Pentium 1/2/3/4/Pro or compatible Processor. The Monitor must be set to High

Colour (16 Bit) or better (in the Monitor Control Panel). Installation requires 50 Mbytes of free

disk space. A CD drive is required for installation (for installation from physical media, not

needed for electronic download). With 128Mbytes you will not be able to open all software at

the same time, but need to close one component of the suite to use the next part.

Preferred requirements : For optimal performance Windows NT4/2000/XP and 256 Mbytes of

memory (512 Mbytes if large data sets, more than 100,000 data points, will be regularly used)

and 1 Gbyte free space on the System Disk (typically C: drive) are recommended. Performance

bottlenecks (and where they typically occur) that may limit the speed of the calculations are the

disk speed (data extraction from DXF and XYZ files, and their gridding), processor speed (the

SIBERIA erosion simulations) and Microsoft OpenGL compatible 3D graphics board (data

visualisation). If these parts of the analysis become limiting then it is suggested that

consideration be given to upgrading these components.

In addition, a considerable amount of disk space can be consumed by the output files. For

instance, a 500 x 500 computational domain (the biggest currently supported by the PC

implementation of EAMS; at 10m spacing this would cover an area 5km by 5km) with

(optional) erosion output data will consume about 20 Mbyte for each time at which data output

is requested. Thus for a simulation over a 100 year design life time with data output every 10

years, the total disk space consumed by one simulation will be about 220 Mbyte (this includes

the time=0 data file with the initial landform). Disk space required is linear with the number of

nodes (i.e. a 250 x 250 simulation uses 25% the space of a 500 x 500 simulation). The monte-

carlo risk assessment capability (currently available only on the UNIX version of EAMS) can

easily consume several Gbytes of disk space in a single simulation.
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2 EAMS Tutorial

2.1 Introduction

EAMS consists of two components.

• The first part is MOSCOW, which calculates the erosion and hydrology properties. To start

MOSCOW you double click on the EAMS-Moscow icon in the PROGRAMS menu under

START.

• The second part is VIEWER, which is used to view the results of the simulations. To start

VIEWER double click on the EAMS-Viewer icon icon in the PROGRAMS menu under

START.

The software has been written in openGL to allow portability across platforms.

EAMS currently runs on Wintel machines and Silicon Graphics Irix V6.0 or later. One of the

unfortunate quirks is that in dialogs you must have the mouse inside a text box when you are

typing at all times. It is not sufficient to click in the window and type away but the mouse must

be inside the window at all times.

Depending on how much memory and free disk space you have you may not be able

to have both applications open at the same time. Typically if the amount of memory in your

machines is less than 128 Mbytes you will only be able to open either Moscow or Viewer, but

not both.

2.2 Erosion Simulation using EAMS-Moscow

To start EAMS-Moscow double click on the EAMS-Moscow icon under the

Programs menu item on the Start menu bar.

On starting Moscow two windows will appear. The main window is a small blue

window appears with a menu bar across the top (with menu bar headings FILE, IMPORT,

SIBERIA, PARAMETER, HELP). The second background window is a larger black window

which will appear in the background. Many diagnostics will appear in this background window.

The menus in the main window are to perform the work and are selected using the left button on

the mouse. To quit MOSCOW pull down the FILE menu and select EXIT.

2.2.1        Importing Elevation Data

Data can be imported in a number of forms from a number of sources. The main

data source of interest here is AutoDesk’s .dxf format which is used by a number of packages as

an interchange format (e. Vulcan, Datamine). We will demonstrate the importation of a .dxf file.

Two example .dxf file are included. They are test1.dxf and test2.dxf. The

remainder of this section assumes that you wish to import file test2.dxf. To import this file

• Select the menu item IMPORT DXF from the IMPORT menu.
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• File name input: You will be prompted for the file name of the data file to import. To select

this file name click with the left mouse button in the OK button. To tell the dialog to select

test2.dxf place the mouse to the right of the *, delete the star and type test2 so that the

dialog now says test2.dxf. Click OK.

• Region for gridding: You will be prompted for the domain to used for the simulation. This

dialog is asking for the east, west, north and south boundaries of the domain to be gridded.

Initially the dialog will have –1 in all four of the boxes. This indicates to the program that it

should grid all the data. If you wish to grid a subset of the data you should input here the

appropriate values. If any one of the four values is –1 then the program will grid all the data

(ie. To grid a subset of the data you must input valid values for all four coordinates). After

inputting these numbers you should click on the OK button.

• Grid Spacing: You will be prompted for the grid spacing to used by this analysis. This grid

spacing is in metres. You should input an appropriate value and click OK. Typically a grid

spacing of about 20m is a good starting value. The value can then be refined in following

runs if necessary. Computation times and disk space limit how fine a resolution you should

adopt. A good rule of thumb is not to have more than 100-200 grid points in either direction

initially as it will take too long to do the calculations (i.e. a 2 km by 4 km square domain

with 20m spacing will have 100 by 200 grid points in the appropriate directions). After

inputting a value press OK.

• At this point there will be a large amount of text printed out to the black background window

behind the main window. Most of this can be ignored. When the text message ‘Finished

writing the raw file’ appears the data importation and gridding of the data is complete. You

have successfully created the digital terrain map to be used for the erosion calculation in the

next step. The name of the file in which the gridded digital terrain map is stored is called

‘test2.grid.raw’. There will also be another file called ‘test2.raw’. This is an intermediate file

that can be useful for more advanced applications. It can be ignored for the moment. These

file names are generated automatically and are based on the name of the input DXF file. For

instance if the input file was called ‘example.dxf’ then the output gridded digital terrain map

file would be called ‘example.grid.raw’. Warning: If a file called ‘test2.grid.raw’ already

exists the gridding step will fail. The moral is always rename or delete the file before doing a

new run. Most of the codes in EAMS will fail if the file already exists This is a safety measure

to ensure you don’t delete important preexisting files by accident.

It in conclusion at the end of this example there will be three files. The first is

‘test2.dxf’, the original file; ‘test2.raw’ an intermediate file you don’t need to worry about at

this stage; and ‘test2.grid.raw’ the final file that has the gridded elevation data in it.
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2.2.1             The Erosion Calculations

This is a simple three stage process. The first stage identifies the input digital terrain map data

to be used, what data needs to be output and the erosion database to use. The second stage sets

run characteristics. The third runs the erosion assessment

Stage 1: Selecting the Data and Erosion Parameters

• Select the INPUT FROM RAW menu item from the SIBERIA menu

• Input the grided digital terrain map data to be used for the simulation. In this case the file is

‘test2.grid.raw’. Click OK to continue

• The next dialog identifies the data to be output from the simulation.

• The ‘Start Time’ gives the year at which the simulation should start. Simply input 0 here.

This is used by the erosion code to automatically generate file names for the output files.

See the next dot points for how this is used.

• For the ‘Output File Name’ you input the file name to be used as the based for the output

file name. You may ignore the selection of raw and rst2 output in the top left corner of

the dialog (it should always have rst2 selected). The default name will be based on the

input file name selected.

• The ‘Number of Outputs’ is the number of times after the start of the simulation at which

output data are wanted. eg. if data were wanted for years 1,5,50 and 100 years into the

future you would input 4 here (because there are 4 times for output; the actual timed will

be input in a moment). See the next dot point for how this is used.

• The ‘Output File Name’ and ‘Start Time’, ‘Number of Outputs’ are used for constructing

the output file names. The ‘Output File Name’ is used as the first part of the file name and

the time at which an output has been requested is added to ‘Start Time’ and this is

appended to this file name. This way a unique file name is created that identifies what

time the file represents. This can be used in two ways; (1) say we are interested in years

after the construction of a landform (and the input landform is this initial landform) then if

we input ‘Output File Name’=junk, ‘Start Time’=0 and we request an output at 50 years

then the file name of the results at 50 years will be ‘junk-0000050.rst2’. If we request it at

100 years then the corresponding file name will be ‘junk-0000100.rst2’; (2) On the other

hand say we are interested in the results at some year in the future and we know what the

year is the simulation starts at then if we input ‘Output File Name’=junk2, ‘Start

Time’=1990 and we request outputs at 1,5, 50 and 100 years then the corresponding file

names will be ‘junk2-0001991.rst2’, ‘junk2-0001995.rst2’, ‘junk2-0002040.rst2’ and

‘junk2-0002090.rst2’.

• After inputting this data you should click on the OK button

• The next dialog asks for the years at which data is to be output (these are the 1, 5, 50, 100

years previously referred to above). The number of years required here is given by the
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‘Number of Outputs’ specified in the previous dialog. Since we input 4 to the previous dialog

there are 4 text fields. You should input 1 in the first text box, 5 in the second, 50 in the third

and 100 in the fourth. This requests output to be generated at times 1, 5, 50 and 100 years

after the start of the run. Click OK when done.

• The next dialog requests the name of the erosion parameter database to be used for this

simulation. With the examples provided with the code is a database called qca-v1.1.sdb.

Enter this name in the dialog and click OK. This selects a database developed for the Bowen

basin coal mines and shows a range of parameter sets for different types of materials. The

exact values are not important for this example, only that there are range of ready made

range of parameter sets for use in the example.

• Immediately after you press OK for selecting the database you are prompted to select a data

set out of the database so as to set default parameters for the run. You can always change this

choice later but you must make a choice at this stage. You can scroll up and down the list by

clicking on the buttons with ‘<’ ‘>’ signs. Select the topmost data set by clicking on

‘OakyCreek_TopSoil_SandyLoam’ and click on the RETRIEVE button. You have now

selected the default parameter values for the simulation.

You have now selected the input data file, the output required and the default

SIBERIA parameters to be output.

Stage 2: Setting the Run Parameters

This stage modifies the default parameters to determine the parameters used for the

simulation. You do this by modifying individual values in the default parameter set that were

input in the previous stage (i.e. Stage 1).

• To select parameters for modification select the EDIT PARAMETERS option from the

PARAMETERS menu. This menu item has further submenus with the options RUN

PARAMETERS, EROSION PARAMETERS, HYDROLOGY PARAMETERS, DTM

PARAMETERS, CHANNEL PARAMETERS, TECTONIC PARAMETERS,

DEPENDENT MODEL PARAMETERS, ADVANCED PARAMETERS #1 and

ADVANCED PARAMETERS #2. These menu items group together all the parameters of

the model into functional groupings. For the moment we will ignore most of these and only

modify the ones that control the direction of the simulation. Accordingly select the RUN

PARAMETERS menu item from the sub menu.

• The RUN PARAMETERS dialog appears with three text items. The topmost of these text

items is the number of years that the simulation will be carried out for. Since we want to get

output for 1, 5, 50 and 100 years we must run the model for 100 years. Input 100 into this

text box. (Aside: If you input 50 here instead of 100 then the model would only run for 50

year and only output the 1,5, and 50 year files … it never gets to 100 years to output the 100

year data). Click OK.
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You have now set all the run parameters that are necessary. You can change

hydrology and erosion parameters at this stage if it is desired. For instance, if a cover factor is

required (eg. vegetation) that can be modified in the EROSION PARAMETERS menu item.

Stage 3: The simulation

To perform the simulation select the menu item RUN SIBERIA from the SIBERIA

menu. This performs the calculations. A large amount of information will appear on the

background window behind the main MOSCOW window (this can be saved, see Section 3 for

details). When STOP appears on the screen the simulation is finished.

You should EXIT (on the FILE menu) from MOSCOW.

When you look in the directory after this example you will find the following

additional files ‘test2-0000001.rst2’, ‘test2-0000005.rst2’, ‘test2-0000050.rst2’ and ‘test2-

0000100.rst2’. Depending on the settings in the file ‘siberia.setup’ you may also find the

following files ‘test2-0000001.rsu’, ‘test2-0000005.rsu’, ‘test2-0000050.rsu’ and ‘test2-

0000100.rsu’.

2.3 Demonstration Simulations

A series of demonstration tutorials are provided in the demonstrations folder (see

under the START menu bar) together with results from the demonstrations. These are provided

as tutorials on how to use the EAMS software together with the answers against which the user

can check their answers to ensure they have the same answers. The general format is that the

required files for the simulation are provided in the ‘demonstration’ folder while the answers

are provided in an appropriately named folder within the demonstration folder.

Before doing any of the demos below you should ensure that SIBERIA will output

the data that you require. Select ‘siberia.setup’ from the START\EAMS menu and open the file

with ‘wordpad’ and uncomment (remove the # in the first column) the command lines that are

OUTPUT ZCHANGE

OUTPUT AVEZCHANGE

Then save the file with the save menu (not the ‘save as’ menu).

By uncommenting these lines this means that SIBERIA will output the elevation

change at every point (ZCHANGE) and average change of elevation for the catchment upstream

of that point (AVEZCHANGE).
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2.3.1 Demo 1

Demo 1 is a small DXF input file example. The .dxf file itself is quite small and the

area covered by the domain is also quite small. This example consists of a flat-topped spoil

dump surrounded on all sides by steep batters.

• Step 1: Start Moscow (from the START Bar).

• Step 2: Since you are inputting a .dxf file select the ‘input DXF’ from the INPUT menu in

Moscow. You will be prompted for the DXF file name. The demonstration folder may be a

bit difficult to find initially. The directory is on the disk that the SYSTEM is installed on

(typically the C: drive) and the directory path is ‘C:\program files\landtech\EAMS\demos’.

If you have trouble finding open the ‘demos’ folder on the EAMS START menu item and

see where this directory is located. After finding the correct directory you will find a file

‘demo1.dxf’, which you should select.

• Step 3: After selecting the correct dxf file you will prompted in a dialog for what portion of

the dxf file you wish to select. Initially it has –1 for all the coordinates for the bottom left

corner and top right hand corner, which indicates that all the data should be input. Click OK

to this dialog so that the program inputs all the data.

• Step 4: After selecting the potion of the domain to be input you will be prompted for the

resolution that the domain will be gridded at (SIBERIA works on a grid). At this stage you

need to know something about the size of the domain being input. For the current limitation

of EAMS you should ensure that the dimensions of the grid are less than 500 x 500 grid

points (i.e. a 10m grid would be able to cover 5km x 5km max, if you want to cover a

greater are you would need to select a lower resolution). For this demonstration if you select

a resolution of 10m then this will give a domain about 150 x150 (as a first step its always

worthwhile doing a coarse resolution run first because it will be fast, then worry about better

resolution if you need to later). Click OK after entering 10m for the resolution.

• Step 5: At this stage EAMS will go off and extract the dxf file and grid the data onto the

domain requested. When the gridding is done there will be a message in the black DOS

window saying that the gridding is complete. At the end of this stage the ‘demos’ folder will

have two additional files in it. The first is ‘demo2.raw’ which is the data extracted from the

dxf file in RAW format, and ‘demo2.grid.raw’ which is the data gridded onto the grid

requested for the boundaries requested, in RAW format.

• Step 6: At this stage you need to set up the data for the SIBERIA run. To do this you must

input the gridded RAW file, select runoff/erosion/run parameter for the SIBERIA run and

tell EAMS what data output is required – actually running SIBERIA is an additional step we

will do later. To do this you select the menu item ‘Input RAW’ under SIBERIA menu item.

The first dialog you will request a generic name for the output files, the number of output

files (the time of output will requested in the next step … we just need to know how many

output are required at this stage), and start date for the run. At this dialog input (1) 0 for the
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Start Time, (2) 2 for the number of output files, and (3) leave the generic name as it is in the

dialog (i.e. C:\program files\landtech\EAMS\demos\demo1).

• Step 7: The next dialog asks for the times at which output is required. Since you input 2 at

the last dialog there are two values to be input. Input 10 in the first item and 100 in the 2nd

item, then click OK.

• Step 8: You are asked to input a SIBERIA database (i.e. a .sdb file). The location of

standard databases is at ‘C:\program files\landtech\EAMS’. Input the file ‘siberia-

parameters.sdb’ and click OK.

• Step 9: After opening the database EAMS asks you select a database. For this demo click on

the item described as ‘OakyCreek_Topsoil_SandyLoam’ (after clicking the name will

appear in the text entry part of the dialog at the bottom. Once this parameter set is elected

click on the RETRIEVE button at the bottom of the dialog.

You have now successfully input the model parameters, and the data on what files to be output

by the model. The next step is to modify these parameters, and then run SIBERIA.

• Step 10: To modify SIBERIA under DATABASE there are a series of submenus of

parameters. Under the RUN parameters menu item change the run time to 100 years (the

default value is 1 year). Under the EROSION parameters can the fluvial erosion rate (the 3rd

item down) to 0.3e-2 (for the OakyCreek data set the default value is 0.3e-3). You have now

modified the parameters for this run so that the run will go for 100 years (instead of 1 year)

and you have increased the erosion rate by a factor of data over the default value in the

database.

You have now modified the parameters and are ready to run SIBERIA.

• Step 11: To run SIBERIA select the menu item for ‘Run SIBERIA’ under the ‘SIBERIA

menu’. A large amount of information will output to the black DOIS screen. When the run

is complete (a few 10’s of seconds on a typical PC) an appropriate message will output on

this screen.

You will now find 4 new files in the demos folder. They are ‘demo1-000010.rst2’ and ‘demo1-

000010.rsu’ which are the output files for 10 years, and are ‘demo1-000100.rst2’ and ‘demo1-

000100.rsu’ which are the output files for 100 years.

2.3.1 Demo 2

Demo 2 is a larger version of Demo 1. It is a near natural landform with a rolling

hill with a drainage line down the centre.

The main difference with demo 1 is that the .dxf file has a much greater number of

x,y,z data values, and it covers a much larger area. Because it covers a larger area you cannot

grid it at the same resolution at 10m.

If you run demo2 putting in all the same information as in demo1 EXCEPT that you

should use a grid resolution of 100m so that a grid of about 60 x 60 is generated. In addition you
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should run it with a resolution of 20m. One of the most useful ways to visualise the data form

this run is to use Viewer to DRAPE the elevation change over the landform. In this case

because the slopes are so low there is very little erosion apparent in the elevations, however, the

plot of Z_change shows the changes quite obviously. If you have trouble seeing the difference

adjust the range of the colour bar and turn the lighting model on. The difference between the

100m and 20m data sets clearly show the effect of increasing data resolution.

After each run you will now find 4 new files in the demos folder. They are ‘demo2-

000010.rst2’ and ‘demo2-000010.rsu’ which are the output files for 10 years, and are ‘demo2-

000100.rst2’ and ‘demo2-000100.rsu’ which are the output files for 100 years.

2.3.1 Demo 3

Demo 3 shows how to use SIBERIA’s capability to have spatially variable erosion

rates, and how to input .rst2 files (instead of .raw files). The RST2 files are the native format of

SIBERIA so they can be input directly into EAMS.

• Step 1: To input the file select then menu item ‘ Input RST’ under the SIBERIA menu. You

will be prompted fro a.rst2 file input. Input the file ‘demo3.rst2’. You will then prompted

for a boundary file and should input the file ‘demo3.bnd’. You have now inputted the

gridded elevation data and the parameters fro the run (the parameters of the run are included

in the header of the RST2 file, so you do not need to input a SIBERIA parameter database.

• Step 2: The next dialog you will request a generic name for the output files, the number of

output files (the time of output will requested in the next step … we just need to know how

many output are required at this stage), and start date for the run. At this dialog input (1) 0

for the Start Time, (2) 2 for the number of output files, and (3) leave the generic name as it

is in the dialog (i.e. C:\program files\landtech\EAMS\demos\demo3).

• Step 3: The next dialog asks for the times at which output is required. Since you input 2 at

the last dialog there are two values to be input. Input 100 in the first item and 1000 in the 2nd

item, then click OK.

You have now successfully input the model parameters, and the data on what files to be output

by the model. The next step is to modify these parameters, and then run SIBERIA.

• Step 4: To modify SIBERIA under DATABASE there are a series of submenus of

parameters. Under the RUN parameters menu item change the run time to 1000 years (the

default value is 1000 years. Note that even though you have changed the value for the length

of run you must at least open up this dialog, otherwise EAMS will not allow you to

continue.

You have now modified the parameters and are ready to run SIBERIA.

• Step 5: To run SIBERIA select the menu item for ‘Run SIBERIA’ under the ‘SIBERIA

menu’. A large amount of information will output to the black DOIS screen. When the run
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is complete (a few 10’s of seconds on a typical PC) an appropriate message will output on

this screen.

You will now find 4 new files in the demos folder. They are ‘demo3-000100.rst2’ and ‘demo3-

000100.rsu’ which are the output files for 100 years, and are ‘demo3-001000.rst2’ and ‘demo3-

001000.rsu’ which are the output files for 1000 years. These four files are for the condition

where the material erodibility is the same over the whole domain.

You should store these four files above in another directory because we are going to

rerun this run and include spatial variable erodibility and we will then compare the results with

Viewer.

You should repeat the steps 1-5 just as above with one important difference. When

changing parameters you should open the EROSION parameters dialog. You should change the

‘erosion model’ to 3 (the first item in the dialog, the default value is 0) and the erosion file (the

second item in the dialog) you should enter ‘demos/demo3.erode’ (the default value is blank).

This tells the model to input spatial variable erodibility (the value of 3) and the read this data

from ‘demos/demo3.erode’. Run SIBERIA after this.

If you input both the RST2 files from the with and without spatial variability in

Viewer you will see that the difference between the two files in the elevations is very small …

in fact its very hard to see from the elevations alone. However, if you plot the ZCHANGE

instead of the elevations you will see in the spatial variability data set that there is a large region

in the left hand of the data set that has near zero erosion. In demo3 this region has an erosion

rate set to a factor of 10 less than the other part of the domain. This region is defined in

‘demo3.rgn’ and if you look in the file demo3.erode (use wordpad) you will see a command

EROSION RELATIVE 0.1 0.7 1.4 ‘demo\demo3.rgn’

This line specifies that the erosion rate in the area specified by demo3.rgn is 0.1 of

the value elsewhere.
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3 Technical Background.

3.1 EAMS

EAMS consists of two linked software packages. The first is EAMS-Moscow

(hereafter simply called Moscow) and the second is EAMS-Viewer (hereafter simply called

Viewer). Moscow basically controls the simulation of the erosion results. Viewer is used to

visualise and analyse the results and prepare data files for Moscow.

Moscow can be considered a menu driven shell that interfaces with a series of other

packages as shown in Figure 3.1. The purpose of the four components is:

• EXTRACT: This package extracts x,y,z data from a range of different file formats and

converts them into a common file format for TIN data (triangulated irregularly spaced

nodes) called .raw format (used by the MinDraft mine management package). Current

supported file formats are (1) AutoCAD’s ASCII dxf format (commonly used by many mine

management packages as an exchange format) and (2) a simple text file format that consists

of x,y,z triples with each triple on each line (again this is a common data file exchange

format). If you are considering relying solely on the dxf file format please ensure that you

read the section below on the dxf file format extraction because not all dxf file formats

(there are many depending on the version of AutoCAD) are currently supported. We do our

best but we can’t keep up with all the changes, documented and undocumented, in the dxf

file format.

• GRID: This package takes the .raw file output from EXTRACT and grids it onto a grid

using a DeLaunay triangulation given the domain characteristics specified by the user. The

data is output into a gridded version of the raw format (called .grid.raw).

MOSCOW

EXTRACT SIBERIA PARAMETER
DATABASE

GRID

Figure 3.1: Schematic of Moscow
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• SIBERIA: This is the long-term erosion model, or landform evolution model. It operates on

a gridded set of elevations. See the next section, and the SIBERIA User Manual provided

with EAMS, for a compendium of its capabilities.

• DATABASE: This is the database of erosion and hydrology parameters. A variety of

parameters are provided by us as a result of our experience. The user can also extend this

database to include their own parameters based on their own data.

Comprehensive details of how these components work and how to control are

provided in the sections below.

3.2 SIBERIA

What follows is a description of the philosophy and methodology used by SIBERIA. Greater

detail can be found in Willgoose, et al. (1989, 1991a-d, 1994), Willgoose (1993, 1994a,b) and

Willgoose and Riley (1993, 1998a,b). For full documentation of the capabilities the user is

referred to the SIBERIA User Manual.

The flood response of a catchment to rainfall is dependent on the geomorphic form

of the catchment. But the catchment runoff not only responds to catchment form, it also shapes

it through the erosion processes that act during runoff events. Over geologic time the catchment

form, shaped by the range of erosion events, reflects the runoff processes that occur within it.

The channel network form and extent reflect the characteristics of both the hillslope and

channel processes. Hydrologists have long parameterised the influence of the geomorphology

on flood response (e.g., Rodriguez-Iturbe and Valdes, 1979). Geomorphologists have largely

fitted statistics to the landscape ignoring the historic processes that created the landscape

(Strahler, 1964; Shreve, 1966) though there have been some notable exceptions to this

generalisation (Gilbert, 1909; Horton, 1945). The difficulty of the problem is such that the

number of researchers that have attempted to unify the geomorphology and the hydrology is

small (Kirkby, 1971; Dunne, 1989; Huggett, 1988), even though the importance of both

specialisations has long been recognised by geomorphologists:

"to look upon the landscape ... without any recognition of the labor expended in
producing it, or of the extraordinary adjustments of streams to structures and of
waste to weather, is like visiting Rome in the ignorant belief that the Romans of
today have no ancestors." (page 268,  Davis, 1954)

The main stumbling blocks to the fulfilment of the promise of this scientific

paradigm have been the range of temporal scales (geologic versus flood event timescales) and

spatial scales (catchment and channel length scales) that are important in the problem; the

heterogeneity in both space and time of the dominant processes; and the problem of the

unification and observation of the processes acting at these disparate scales. Physically based

computer models of catchment development (e.g., Ahnert, 1976; Kirkby, 1987) are important

tools in the understanding of the interactions between hydrologic process and response,

primarily because of their ability to explore the sensitivity of the system to changes in the
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physical conditions, without many of the difficulties of identification and generalisation

associated with the heterogeneity encountered in field studies.

The ultimate goal is to develop a quantitative understanding of how channel

networks and hillslopes evolve with time using a computer model of landscape evolution.

Catchment form and hydrologic response will then be seen in the context of the complete

history of erosion development of the catchment.

A large scale model of catchment evolution (SIBERIA) involving channel network

growth and elevation evolution is documented below. This model integrates a model of erosion

processes, theoretically and experimentally verified at small scales, with a physically based

conceptualisation of the channel growth process. Neither the properties of the channel network

nor the properties of the hillslopes can be viewed in isolation. They must be viewed as

components of a complicated large scale non linear system: the drainage basin. The basic tenet

of this work is that it is necessary to understand the physics of the catchment processes to be

able to fully understand the catchment form and that it is necessary to " ... identify linked

process equations and so define geomorphic systems in such a way that an analytical, predictive

approach can be used ..." (p. 48, Huggett, 1988). It is not claimed, nor is it intended, that the

model presented below account for all the processes occurring in the catchment. Rather a

general model framework is presented which is both physically realistic and incorporates the

dominant physical processes and which provides a useful tool for the study of the important

interactions within the catchment. It is, however, believed to model the dominant processes

occurring in fluvial landforms.

A crucial component of this model is that it explicitly incorporates the interaction

between the hillslopes and the growing channel network based on physically observable

mechanisms. An important, and explicit, differentiation between the processes that act on the

hillslopes and in the channels is made. A point is defined to be a channel when selected flow

and transport processes exceed a threshold value. If a function (called the channel initiation

function) is greater than some predetermined threshold at a point, then the channel head

advances to that point. The channel initiation function is primarily dependent on the discharge

and the slope at that point, and the channel initiation threshold is dependent on the resistance of

the catchment to channelisation. Channel growth is thus governed by the hillslope form and

processes that occur upstream of the channel head. The channel initiation function is

independent of Smith and Bretherton’s (1972) definition of channels as points of instability in

the flow equations. Nevertheless, these concepts are not necessarily contradictory. This is

particularly true given the recent realisation that Smith and Bretherton’s analysis would lead to

a system of rills spaced at an “infinitesimal distance apart” unless a basic scale is built into the

equations (Loewenherz-Lawrence, 1990). Introducing this scale of separation is conceptually

consistent with the threshold analogy. The elevations on the hillslopes and the growing channels

interact through the different transport processes in each regime and the preferred drainage to

the channels that result. The interaction of these processes produces the long–term form of
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catchments. The preferential erosion in the channels results in the familiar pattern of hills and

valleys with hillslope flow being towards the channel network in the bottoms of the valleys.

The model below simulates the growth and evolution of the channel networks and

the contributing hillslopes. Two variables are solved for in the plane: the catchment elevation

and an indicator variable that identifies where channels exist in space. In the computer

implementation (computer code SIBERIA) a drainage direction is assigned to each node in the

discretized space on the basis of the direction of steepest slope from node to node. These

drainage directions are used to determine the area contributing to (i.e., flowing through) each

node. From these areas, and thus discharge, and the steepest slopes at the nodes, continuity

equations for flow and sediment transport are written. These areas and steepest slopes are also

used to evaluate the channel initiation function (which may be, for example, overland flow

velocity) which is then used in the channelisation function to determine regions of active

channel network extension.

The governing differential equations for elevation and channel indicator functions

are:

∂z

∂t
= U +

1

b

∂qsx

∂x
+

∂qsy

∂y

 
 
  

 
+ D

∂2z

∂x2 +
∂2 z

∂y2

 
 
  

 
(3.1)

∂Y

∂t
= f dt , Y,  

a

at

 
 
  

 
 (3.2)

where in Equation (3.1) z is the elevation (positive upwards); x and y the horizontal directions; t
time; U the tectonic uplift per unit time; b the bulk density of the soil (where the sediment flux

is in units of mass/time); qsx and qsy the sediment transport in x and y directions; and D is the

diffusivity. Equation (3.1) is simply a continuity equation for sediment transport. In Equation

(3.2) Y is the variable describing whether that point in the catchment is a channel (Y≈1) or a

hillslope (Y≈0), dt is the rate of channel growth at a point, and a and at are the channel initiation

function and its threshold respectively. Equation (3.2) describes the transition of a point in the

catchment from hillslope to channel on the basis of a threshold in the channel initiation function

a. The constitutive equations that are used for channel initiation function, a, and sediment
transport, qs, are those that apply in the region being modelled. Here we use (the details of these

equations may be slightly different from the implementation depending on the input parameters

for the computer simulations, see later sections for these details)

a = 5q
m5 Sn5

(3.3)

qs = Kqm1Sn 1

(3.4)

K = G ⋅ f Y( ) (3.5)
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f (Y) = 1 Y = 1 (channel)

1Ot Y = 0 (hillslope)

 
 
 

(3.6)

where q is the discharge per unit width, 1 and 5 are rate constants that may be variable on

space and m1, n1, m5, n5 are typically constants with respect to space and time (though that

restriction can be loosened in various ways within the model). K is the erodibility. The
coefficient Ot represents a reduction factor, in a reduction exists, in sediment transport rate in

the hillslopes compared to that in channels. The factor G is related to the runoff processes to be

modelled and assumes particular importance when the subsurface saturation runoff mechanism

is simulated. For Hortonian runoff G=1. Methods for determining the other coefficients from
the governing physics will discussed later in this chapter. The discharge in a channel, Qc, and

the discharge per unit width, q, again may be parameterised in any way suitable. We choose to

represent them here as

Qc = 3Am3 (3.7)

q =
Qc

w
(3.8)

w = 4Qc
m4 (3.9)

where A is the catchment area draining to that point in the channel, w is the width of the channel
at that point, 3 and 4 are constants that may be variable on space and m3 and m4 are constants

with respect to time and space. The equations are solved on a spatial domain with boundary

conditions

∂z

∂p
= 0 (3.10)

where p is the direction perpendicular to the catchment boundary.

 The governing equations are non linear partial differential equations of two states;

these two states are elevation, z, and an indicator variable for channelisation, Y. The most

important qualitative characteristic of a catchment, the branched network of channels that form

the backbone of the drainage system of a basin, is thus explicitly modelled. There are five

important variables distributed in space, that are derived from these two states. They are the

steepest downhill slope, the contributing area, the discharge, and the distribution of channel

initiation function and sediment transport in space. The channel initiation function and sediment

transport feed back into, as inputs, the two state equations for elevation and channelisation.

Thus there is a non linear interaction between the elevation and channelisation, and the channel

initiation function and sediment transport in space. This interaction is the central feature of the

model that drives the drainage network growth.
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3.3 Extended Output from SIBERIA

The level of detail output of the erosion model is controlled by a file called ‘siberia.setup’. All

of the extended capabilities of the erosion model SIBERIA are controlled by this file. A sample

file is provided with MOSCOW with more complete documentation of how to use it written

into the file. Below is simply a summary of its capabilities. Comments in this file are denoted

by a ‘#’ character in the first column. All of the commands discussed below are written into this

file, all the user has to do is uncomment them out (using Wordpad or some other similar text

editor) to make them active.

3.3.1             Storing Diagnostic Output from SIBERIA

Diagnostic output is all the output that is written out to the text window behind MOSCOW as

the code is running. This data is sometimes useful to check that a run has been performed

correctly or that to check on some more detailed characteristics of the simulation. The command

to output diagnostic output to a file is

ECHO FILENAME

where file name is the name of the file that you want the information go to.

3.3.2              More Detailed Data Output

By default the erosion model SIBERIA outputs 8 internal variables from the model. These are

output in the file whose name ends with ‘.rst2’. These are for each point on the grid (1) slope,

(2) a spatial variation variable, (2) a variable that indicates whether a channel or gully exists at

that point, (4) elevation, (5) area draining through that point, (6) the direction that water drains

at that point (7) the depth of any channel at that point and (8) the depth of the soil at that point.

Not all of this output is necessarily meaningful as it depends upon what components of the

model are active and what parameters are meaningful. Some of these states (eg. channel depth

and soil depth) are still in research stage and will not be reliable until a great deal more research

is done on channel and soil model.

SIBERIA is also able of putting out other data from the simulation and the user can

control which, if any, they want. These are controlled by the file siberia.setup. The generic form

of the command to output a particular characteristic is

OUTPUT characteristic

Where ‘characteristic’ is one of the data types that SIBERIA can output. They are documented

in the siberia.setup file but include (this is not a compete list … see the file for more recent

options)
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YIELD: This is the rate of loss of elevation per year (in mm/year) at that point in the grid at the

time at which the file was output.

AVEYIELD: This is the rate of loss of elevation per year (in mm/year) averaged over the

catchment draining though that point in the grid at the time at which the

file was output. The difference with YIELD is that yield is for that point

in the grid while AVEYIELD is the average for the catchment draining

through that point.

ZCHANGE: The is the elevation change at the point since the start of the simulation.

AVEZCHANGE: As for AVEYIELD this is the elevation change for the catchment draining

through that point since the start of the simulation (note that if the

drainage pattern has changed during the simulation the beginning and

end catchment will not be the same).

GULLYPOT: Is a plot of the Channel Initiation Function (CIF, see the channel model)

throughout the catchment. Even if the channel model is not activate this

may be a useful indicator of regions of high risk of gully erosion.

LOGGULLYPOT: Is the log of GULLYPOT. The log may be useful to plot because the

typical range of GULLYPOT is normally extremely large and typically

ranges over several orders of magnitude.

TONNESHECTARE: This is YIELD with the units of tonnes/hectare rather than mm

elevation change. This is simply a conversion based on bulk density.

AVETONNESHECTARE: This is AVEYIELD with the units of tonnes/hectare rather than

mm elevation change. This is simply a conversion based on bulk

density.

3.3.3            Inputting Regions of Spatially Variable Runoff/Erosion

SIBERIA has the capability to inputs regions that have different runoff and erosion properties

from surrounding areas. The general principle is that a default set of hydrology and erosion

parameters are specified exactly as we have done with the database above. These are assumed

to apply everywhere in the region, except where we say other parameters are to apply. We

specify where these other parameters apply and what values these parameters have in another

file. An example file called test.erode is included to show the principle. This file must be

constructed with an editor separately from the MOSCOW parameter dialogs. Comments in this

file are indicated by ‘#’ in the first column.

The principle is that we define a region over which the new parameters will apply

(using the region capability of VIEWER, see Section 2.4), we specify which of both or either of

the runoff and erosion properties are to be changed in that region, and how those values are to

be changed. A sample command to modify the erosion parameters is
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erosion absolute 0.01 0.6 0.7 'test1.rgn'

The general form of this command is that

• the first word is erosion to indicate that this is to modify the erosion parameters

• the second work is either ‘relative’ or ‘absolute’ to indicate how the parameters are to

modified. ‘absolute’ means in the region over which parameters are to changed that the

default parameters are to be replaced by the values specified here. ‘relative’ means that

the default parameters are to be multiplied by the values here.

• The next 3 numbers are the new parameters in the order, coefficient on the fluvial

sediment transport equation, exponent on discharge and exponent on slope.

• Finally the file that specifies the region (called a region file) over which the parameters

are to apply. This file name should be surrounded by apostrophes.

The general form of the runoff command looks similar to this with some slight

modifications

runoff absolute 1.0 0.8 'test0.rgn'

where

• The first word is runoff to indicate that we wish to modify the runoff parameters

• The second word is ‘relative’ or ‘absolute’ as for the erosion command

• The next two parameters are the runoff parameters in the order coefficient and exponent

on area in the discharge equation respectively.

• Finally the region file for the new parameters.

The recommended method for constructing this file is to copy the example

‘test.erode’ and edit and copy individual lines in the file.

To input the file to MOSCOW the following process must be followed

RUNOFF: The Runoff model in the RUNOFF PARAMETERS dialog must be set to 3 and the

name of the file that you have just constructed above must be input into the Runoff Model file

box directly below in the dialog.

EROSION: The Erosion model in the EROSION PARAMETERS dialog must be set to 3 and

the name of the file that you have just constructed above must be input into the Erosion Model

file box directly below in the dialog.
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Finally, if you wish to modify both runoff and erosion properties in the one run you

can mix erosion and runoff commands in the one file and input the same file name to the two

different file boxes above.
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(2) EAMS Moscow Menu Options

Moscow has 5 pull down menus.

The are operated by using the left-hand mouse

button. The FILE and HELP menus are self-

explanatory. HELP brings up help files in

Internet Explorer and you can then explore the capabilities of Moscow in much the same way as

you explore an Internet web site.

4.1 IMPORT Menu

Importing a digital elevation map and gridding these elevations onto a grid is a

single stage process where you specify the input file name, the area to be extracted and the

resolution of the grid to be generated. It is slected by choosing one of the menu options

‘Import>Import DXF File’, ‘Import>Import XYZ File’ or ‘Import>Import RAW File’.

The menu controls the import of

non-native file types into Moscow and their

gridding. Three file types are supported. For

all three file types the data that is requested

next is the same so we will not distinguish

between the three in the discussion below. The details of the format of the files are outlined in

the section 4.1.1. After triggering the menu you will be prompted for the file name of the to be

input. Subsequently you will be prompted for the X and Y coordinates of the edges of the area

to be gridded and for the resolution of the grid to be used for gridding the data.

Immediately after selecting the Import

menu the user is asked for the name of the file to be

imported. Only files with the correct extension are

shown (i.e. .dxf for DXF files, .xyz for XYZ files and

.raw for RAW files).

Next the eastings and northings of the

domain to be gridded are requested. This dialog allows you to extract a small portion from a file

that covers a much larger area.

The initial information in the dialog is all –1’s as in the figure to the left. If you

leave these –1s and simply click OK to this dialog the code will grid all the data in the file. To

do this it analyses the input data and makes the west-most point the western edge of the domain

and the southern-most point the southern edge of the domain. The eastern edge of the domain is

the nearest grid point that encompasses all the data so that the eastern most point is just inside

the eastern most edge of the grid. The procedure is similar for the northern edge of the domain.

If you wish to grid only a portion of the file then you must enter the eastings and

northings of the portion to be extracted from the file. The top line of the dialog is the easting
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and northing of the south-west corner of the domain (i.e. bottom left corner of the map) and the

bottom line is the easting and northing of the north-east corner (i.e. top right corner of the map).

If the distance from the western to eastern boundary is an even multiple of the grid resolution

then the eastern edge of the grid coincides with the eastern boundary entered (likewise for the

northings). On the other hand if the distance is not an integer multiple of the grid resolution then

the eastern boundary of the grid is the nearest integer multiple of the grid resolution that is just

to the west of the eastern boundary. Thus the eastern edge of the grid is just to the west of the

input value for the north-east corner. The process is the same for the northings.

Finally, when the boundaries are specified only those points inside the boundaries

are used in the gridding. Points outside the boundary are ignored.

After inputting the information about the

boundaries of the domain to be extracted and gridded

the next dialog asks for the resolution of the grid onto

to which the input elevation data is to be gridded. Enter

the appropriate value and continue.

Immediately

after you respond with the

resolution of the grid the

extraction will start. During

this time a series of

information lines will be

output to the command

window. The window to the

left shows the start of a

typical dxf file extraction.

Most of this will not be of interest to users so you may skip to reading the next section at this

stage. However, sometimes this data will be useful for diagnosing a problem in the input files.

The 6 lines immediately after “INPUT BOUNDARIES” indicate the range of values that will be

extracted from the file. Here the –1s against the northings and easting indicate that all data will

be extracted. The next two lines show the maximum and minimum elevations that will

accepted. These latter two values cannot be changed but reflect the highest and lowest

elevations on the Earth, in metres. Be aware that if you have data outside this range it will be

skipped. We have occasionally seen dxf files where the elevations have been in cm’s or mm’s

and their values lay outside this range. In this case the data cannot extracted until the original

files are converted in metres. It is possible the same may occur if the elevations are expressed in

feet.

For every 10,000 lines in a dxf file a progress line is written to the screen. Likewise

for every 10,000 valid (x,y,z) triples extracted a progress line is output. If you are inputting a

large file (several 100,000 data points or more) you may want to take a coffee break because a
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dxf file can be VERY large and is consequently very slow to input (much slower than an

equivalent XYZ file).

4.1.1             The File Types

4.1.1.1 DXF Import

A DXF file is a simple text file (there is binary version of the DXF format but is not

widely supported so we do not support it in EAMS) that includes all information describing an

object. It is a much more general format than simply the elevations of a surface since it is used

for all sorts of engineering design applications. This means it is capable of representing

complex objects ranging from mechanical parts like components of an engine to cartographic

information including everything that is shown on a topographic map, including land use,

houses, roads, names as well as the actual elevations. In addition Autodesk (the developers of

AutoCAD, the originator of the DXF format) are continually upgrading the format as they

upgrade AutoCAD. Each new revision of AutoCAD results in major increases in the

capabilities (and thus the complexity of reading) of the DXF format. On the other hand the DXF

format is a common exchange format used by Mine Management packages.

However, writing a general DXF reader is considered a very difficult task. In

general any DXF reader can only read a subset of the DXF files presented to it, and this is true

even for any given version of the DXF format. The DXF reader in EAMS generally conforms

with V11 of AutoCAD (i.e. it can read anything output by V11 of AutoCAD, with some

limitations listed below) but is also capable of reading some data generated by later versions of

the file format.

The known limitations in the DXF Import software:

• Layers are ignored. The reader reads all recognised x,y,z triples, ignoring any layer

information. Thus you should only output from your CAD package those layers which

include surface elevation information.

If you have a file that you cannot be read by EAMS (a good indication of this is that

it extracts many less valid data points than you think are in the file) please send us the file and

we will attempt to incorporate the missing reading capabilities in the next revision of EAMS.

This is true even if you are able to work around this problem by generating an earlier version of

the DXF file with your CAD software.

4.1.1.2 XYZ Import

This file is particularly simple and, if need be, can be easily created by just about

any program. Many CAD packages can generate this format or something closely

approximating it. It simply consists of a series of lines, with one data point per line. Each line

has on it the x, y and z coordinates of the data point. The 3 data values should be separated by



EAMS 2.00 User Manual 24

spaces. There should be no lines of information before the first data point and there should be

no information in the file after the last data point.

4.1.1.3 RAW Import

This is the native file format used by the MINDRAFT mine management package. It

is also the native format of EAMS. The user may then ask why there is a RAW import option at

all? You will soon realise that the import of dxf files in particular is quite slow and there may be

times when you wish to grid the same domain with a variety of resolutions (e.g. 2m, 5m, 10m)

to see the effect of grid size, etc on the model predictions, etc. In this case you can extract the

dxf file first time through (which creates a raw file of the x,y,z data) and in subsequent gridding

you can use the raw file extracted first time through instead of re-extracting the dxf file. This

way you can skip the dxf extraction on subsequent time through the gridding. A .raw file is

generated as an intermediate step between dxf (and xyz) extraction and before gridding. It has

the same name as the original file but with the .raw extension. If the original file was

‘sample1.dxf’ then after dxf extraction there will be file called ‘sample1.raw’ which consists of

the (x,y,z) data in MINDRAFT format. There will also be a file called ‘sample1.grid.raw’ but

this is the data after gridding in MINDRAFT format. Remember .raw files are the original x,y,z

data while .grid.raw are the result of gridding that data.

Thus to skip the extraction of the dxf file use the .raw file from the previous

extraction. Note you will still be prompted for the boundaries. The boundaries are used in the

gridding process, NOT the extraction so when the original .raw file is created it will have the

elevations for the entire domain. So if you enter –1’s you will get the whole domain of the

original dxf file.

4.1.2              Gridding Data

The gridding is done by:

• Creating a DeLaunay triangulation of all the points inside the specified domain.

• Interpolating the elevations for the grid off the DeLaunay triangulation.

Since only points inside the domain are using in creating the triangulation then there

will a small area along the edges of the boundary that cannot be gridded. This is the region

where a triangle would otherwise have been created that would traverse the boundary with some

vertices inside the boundary and some outside. If this is a problem then the user should consider

using a larger boundary.

Be mindful, however, that even in this case the boundaries may need to be some

distance from the edge of the region being studied by SIBERIA, otherwise there may be

boundary effects on the erosion simulations. An example of this would be where deposition in

the real world is creating an alluvial fan that extends out to the boundary. On the boundary of

the domain SIBERIA imposes fixed elevations which will suppress the alluvial fan in the

simulation (because the elevations can’t increase at the boundary). This suppression of
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deposition may propagate upstream, and effect the simulated erosion and deposition some

distance from the boundary.

4.2 SIBERIA Menu

Once the elevation data is

extracted and gridded simulation with

SIBERIA is a two stage process. The first

stage is to tell EAMS what the run

characteristics are going to be (e.g. model

parameters, run time, at what times to output data for analysis). The second stage is to actually

run SIBERIA.

We discuss the first stage first. This stage is triggered by selection of one of the two

menu options ‘Siberia>Input from RST2’ or ‘Siberia>Input from RAW’.

The first dialog presented is a file input dialog for the elevation to be used as the

initial conditions for the simulation.

• For RAW input there is a single file dialog requesting the .grid.raw file to be used for input.

• For RST2 input two file dialogs are presented one after the other. The first file dialog

requests the RST2 file to be input. This file has in it elevations and parameters, as well as

other information that may or may not be used by SIBERIA depending on the run options

requested for the SIBERIA run in the dialogs that follow. The second file dialog requests

the BND file that for that RST2 file. This file has the computational boundaries in it (i.e.

what nodes are used in the calculations and which ones are ignored). Some RST2 files do

not need BND files. In this latter case you should just press cancel for the BND file dialog

without selecting a file.

The directory that the RST2 or RAW file resides in is then set as the default

directory for all the output files.

The dialogs that follow are the same for both RST2 and RAW input.

The next dialog inputs information about the data files to be output with the results

of the simulation in them. By default, the user should not change the format of the file to be

output from the default (RST2, indicated by the radio button in the top right hand corner) RST2

file format. This is the file format expected by Viewer. RAW file format can only be viewed by

MINDRAFT and the ACIRL mine rehabilitation package ARGUS.
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The next item to fill out in the dialog is the generic filename for the output. The

default entry in this field is the directory in which the original RST2 or RAW file is in and the

filename is the same file name as this initial filename. The actual filename is made by using this

generic filename as a starting point and then appending onto it the time at which the output is

made by SIBERIA. The process of construction this file name is fairly straight forward. It is the

number of timesteps of the simulation plus the ‘Start time’ entered in this dialog. Thus if you

request that output is to be produced after 12 timesteps/years (the input of this data comes in the

dialog) and you input 1970 as the start time then in this example the file name of that output

will be test-0001982.rst2.

Finally the last piece of information in this dialog is the ‘number of outputs’ to be

produced. This is the number of times at which you will want output. This of you want outputs

at times 10 and 20 you should input ‘Number of Outputs’=2. Then press OK to this dialog.

After this another dialog comes up which request the

times at which outputs are requested. It has the same number of input

boxes as requested in the previous dialog for ‘Number of Outputs’.

In the case at left because you input 2 at the previous dialog there are

2 boxes. If are more than 10 times the first 10 will be requested and a

new dialog will request the next 10, etc until all the times are input.

The times of output should be input in ascending order.

Once these data are input you are ready to set up the characteristics of the SIBERIA

run. This process is a little different for RAW file input and RST file input so please continue

with appropriate section that follows.

4.2.1              RST2 Input

The next step involves setting the run parameters, erosion parameters, hydrology

parameters, etc. Default parameters for the simulation are read from the RST2 file. These

parameters are in the first 27 lines of the RST2 file, but unless you know what you are doing we

discourage you from messing with this file because SIBERIA expects it in a very specific form.

These parameters need to be finetuned for your simulation. EAMS will not allow you to run

SIBERIA until you have done this.
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Details of the various parameter options see Section 4.3.2. As an absolute minimum

you will need to specify the run time in years of the simulation (this is the ‘Run Parameters’

dialog). Once you have done this you can then go to the menu ‘Run Siberia’ in Section 4.2.3.

4.2.2              RAW Input

The next step involves setting the run parameters, erosion parameters, hydrology

parameters, etc. If you have requested input from a RAW file you will be immediately asked to

open a SIBERIA database (go to ‘Open Database’ section of Section 4.3 to see how this works)

and select a parameter data set to be used. This parameter set then becomes the default

parameter set for your run. You can always go back and select a new parameter set, and this

will overwrite all your current parameters.

One you have input the database you must modify the parameters for the SIBERIA

run. The database selection process above for RAW files reads default values from the database.

You still need to finetune them for your simulation. EAMS will not allow you to run SIBERIA

until you have done this.

Details of the various parameter options see Section 4.3.2. As an absolute minimum

you will need to specify the run time in years of the simulation (this is the ‘Run Parameters’

dialog). Once you have done this you can then go to the menu ‘Run Siberia’ in Section 4.2.3.

4.2.3              RUN SIBERIA

When you select this menu option two things are done

• The data files required by SIBERIA are constructed. The details of this process are not

important but sometimes it may be necessary for us to look at these files to diagnose a bug

in the software, or a run time problem you are having. The run data is all summarised in the

file ‘siberiakb.com’ in the ‘Program Files’ directory on the System Disk. In addition for

RAW file input the requisite RST2 (i.e. initial elevations and dummy parameters) and BND

(i.e. computational boundaries) files expected by SIBERIA will be generated. The names of

these files are based on the name of the input RAW file. If the input raw file is call

‘junk.raw’ then the RST2 file name will be called ‘junk-start.rst2’ and the boundary file will

be called ‘junk.bnd’. The RST2 file can be used in EAMS-Viewer just like any other RST2

file (i.e. just checking to make sure the data is OK or perhaps selecting regions that have

different erodibilities or runoff, etc).

• SIBERIA is run using the data files just constructed.

4.3 DATABASE Menu

This menu controls the opening and manipulation of the database(s) containing the

SIBERIA parameters.
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The process that needs to be

followed here is to open a SIBERIA

parameters database, select a set of parameters

that are considered by the user to be

appropriate, and then edit these parameters to

set up the run.

4.3.1              Open Database

The EAMS distribution

installation supplies a number of

standard databases. In addition you

may create your own for your project

(more on that later). The extension

for a SIBERIA database is ‘.sdb’. The

standard databases are to be found in

the program files directory on the

system disk.

When you have selected a

database you will be prompted by a dialog to select

a parameter set from this database. A typical

database is shown to the left. The large scrolling

window (up and down are controlled by the left and

right arrows near the bottom right of the window)

consists of a series of names for datasets. To select a

dataset you simply scroll up and down until you find

the set you want and click once on the name to

highlight it (it will also appear in the text box at the

bottom of the dialog; in this case we show selection

of ‘Wandoan_Soil_ClayLoam’) and then click on

the ‘Retrieve’ button to extract those parameters

from the database.

Do not worry if you have selected the

wrong dataset because you can always go back and

select a new data set with the ‘Database Record’ menu item in the original Database menu. This

menu item simply returns you to parameter set selection dialog above.
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4.3.2              Database         Record

This menu item simply returns you to parameter set selection dialog above. This

allows you to input a new parameter set without having to first select the parameter database.

4.3.3             Set Parameters

Once you get to using this set of menu items you will have extracted the default

erosion, hydrology and other parameters from the database. You now need to finetune the

SIBERIA run characteristics (mainly how long do you want to run the simulation for, perhaps

different hydrology and erosion characteristics). At very least you will wish to check that the

default values are in fact appropriate for your problem. The ‘Edit Parameters’ menu item above

provides access to all the current values for the parameters that are required for a SIBERIA run.

EAMS requires you check the parameters before you will be allowed to Run

SIBERIA. At very least you will always have to select the ‘Run Parameters’ to set the duration

of the run. If you don’t EAMS will refuse to run SIBERIA. You may choose to select other

parameters as well but they are not compulsory.
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4.3.3.1 Run Parameters

SIBERIA names for Parameters:

1: RunTime (§3.2.1)

2: InitTimeStep (§3.2.2)

3: StatsTime (§3.2.1)

The run time is the duration (timesteps) from beginning to end of the simulation.

The units of years imply that the erodibility and tectonics parameters are for that process per

year (i.e. one timestep = one year). [ADVANCED: While this is the default option this is not

the only way to use this capability. The run time could be interpreted as months provided the

rates of the processes are calculated to be per month. For instance you could input that the run

time is to be 10 years in which case b1 will be interpreted as the erodibility of the material/year.

However, if you divided b1 by 12 then you could run the model for 120 time steps and get the

same result. While normally you will be interested in the erosion per year there can be

occasions where having better temporal resolution can be useful].

The Time Step (i.e. InitTimeStep ) is the resolution used internally within SIBERIA

during its calculations. The appropriate size of the time step is determined by the stability and

mass balance compliance of the solver. If you input a negative number then SIBERIA will

dynamically estimate the time step based on an approximate and empirical criteria based on a

maximum 1% mass balance error (use this option with caution for DEM’s with large flat areas

as it can sometimes set ridiculously small timesteps). In either case the user should assure

themself that the resolution is high enough to ensure that the results are correct. For a typical

temperate climate, a resolution of the DEM of 10m and moderate slopes (mostly less than 20%),

a normal agricultural soil and a domain of size 1km x 1km a good starting point for a time step

is about 0.01 when the time step is in years. This is not, however, a golden rule and it is

sometimes useful to start with a very large timestep to get a rough, qualitative idea of what the

erosion is like without excessive computational times, particularly if you are working with a

large domain. If you do this be aware that the results may be grossly in error and it is possible

that SIBERIA will crash and burn without warning.

The period between diagnostic statistics is simply the time at which summary

statistics are output to the DOS window. This output is particularly useful when the user sets

‘siberia.setup’ to echo all simulation output to a file. In this case the diagnostic statistics are

output to the file specified in ‘siberia.setup’ as well as to the screen. This allows some simple

monitoring of simulation output, such as is sometimes required to correctly set the timestep for

difficult problems.
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4.3.3.2 Erosion Parameter

SIBERIA names for Parameters:

1: ModeErode (§3.2.1)

2: FileErode (§3.2.3)

3: b1 (§3.2.2)

4: m1 (§3.2.2)

5: n1 (§3.2.2)

6: QsHold (§3.2.2)

7: b12 (§3.2.2)

8: m12 (§3.2.2)

9: Ot (§3.2.2)

10: Bulk (§3.2.2)

11: Cover (§3.2.2)

12: dZ (§3.2.2)

13: dZn (§3.2.2)

14: dZHold (§3.2.2)

There are a range of erosion models that can be selected. Full details of the

capabilities of this component of the model are to be found in the SIBERIA User Manual.

The erosion model selected is determined by the value of ModeErode. The default

model is invoked by either ModeErode equal to 0 or 20. When either ModeRunoff (see the

runoff parameters) or ModeErode is greater than or equal to 20 the grid resolution input by

GridXY in the DEM options parameters is used and all properties are input as per unit width.

When both ModeRunoff and ModeErode are less than 20 the grid resolution is assumed by the

model to be 1 and GridXY is ignored so that all properties are per node. Normally a user will

input ModeErode=20 to select the default erosion model while using GridXY.

For the default erosion mode with fluvial erosion the typical user will input values

for b1, m1, n1, Bulk and Cover. If they have the data to calibrate the soil creep they will also

input a value for dZ. All other parameters would normally be left as the default values.

Some notes can be made about the units of the processes. It is here that most

mistakes are made in setting parameters. The parameter b1 would normally be calibrated such

that the erosion is measured in cubic metres of sediment per unit time and per unit width of flow

and the bulk density would be input as tonnes per cubic metre. This ensures that the elevation

changes calculated by the model are in metres. For the diffusivity dZ the units here are in cubic

metres of bulk soil per unit time and per unit width.
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The user should also remember that in the absence of channels (see the channel

model) the erosion rate for the domain (which is hillslope) is

    qs = 1Otq
m1Sn1

so the presence of the term   Ot  
should not be neglected in the determination of the parameter

values. It is suggested that in cases where channels/gullies are not modelled that   Ot  should be

set to be equal to 1.

As a final check that the correct parameters are determined it is worthwhile to check

by hand that the correct amount of material is lost per year during the simulation by comparing

it with what the calibration data would suggest. This can be easily checked locally by looking at

erosion lost/year in Viewer (i.e. the mean elevation over some set portion of the domain for two

different times of a simulation). A more accurate estimates can be determined by looking at the

change in total mass in the statistics controlled by StatsTime in the ‘Run Parameters’ dialog.

Total mass is simply the sum of the elevation of every node in the domain. Thus the erosion loss

can easily be calculated by taking the difference between total mass at two times, and dividing it

by the number of years between the two times and the number of nodes (given by ‘Total Area’

in the same table of statitsics) to give the elevation change per unit time. The statistics tabled

used here can be accessed in the log file specified for output in the file ‘siberia.setup’.

For methods to calibrate b1 the user is referred to the SIBERIA User Manual.
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4.3.3.3 Hydrology Parameters

SIBERIA names for Parameters:

1: ModeRunoff (§3.2.1)

2: FileRunoff (§3.2.3)

3: ModeDir (§3.2.1)

4: FileCtrBank (§3.2.3)

5: b3 (§3.2.2)

6: m3 (§3.2.2)

There are a range of runoff models that can be selected. Full details of the

capabilities of this component of the model are to be found in the SIBERIA User Manual.

The runoff model selected is determined by the value of ModeRunoff. The default

model is invoked by either ModeRunoff equal to 0 or 20. When either ModeRunoff or

ModeErode (see the erosion parameters) is greater than or equal to 20 the grid resolution input

by GridXY in the DEM options parameters is used and all properties are input as per unit width.

When both ModeRunoff and ModeErode are less than 20 the grid resolution is assumed by the

model to be 1 and GridXY is ignored so that all properties are per node. Normally a user will

input ModeRunoff=20 to select the default runoff model while using GridXY.

For the default runoff mode the typical user will input values for b3 and m3. All

other parameters would normally be left as the default values.

Some notes can be made about the units of the processes. It is here that most

mistakes are made in setting parameters. The parameter b3 would normally be calibrated such

that the runoff is measured in cubic metres of runoff per second for a 1 in 2 year runoff event

(see the SIBERIA User Manual for the reasoning behind this choice) per unit width of flow.

This discharge is then used in the calibration of the erosion model.

In the event that the runoff properties of the landform themselves are not of interest

to the user then a simpler calibration approach is possible which mean that output runoff values

are not meaningful but the erosion predictions are still correct. If the default runoff model is

substituted into the erosion equation then the following equation results

    
qs = K 3

m1( )Am1m3 S n1 = ′ K A ′ m S n1

and given a known area and slope for a plot to correctly calculate the erosion all that is

necessary is to calibrate   ′ K  to the data. When inputting this into EAMS it is sufficient to set

  3 = 1 and     m3 =1 , and then set the erosion parameters such that   K = ′ K  and     m1 = ′ m .
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One simple way to do this calibration is to use another model (e.g. USLE,

CREAMS, WEPP) to predict the erosion rate on a range of plots with different lengths and

slopes over the range likely to be encountered in your problem (we recommend at least 3 of

each). Then use this data to do a multiple regression against area and slope to determine the

values of   ′ K ,   ′ m , and     n1.

The parameter ModeDir is most useful for inputting contour banks where flow is

constrained in the directions it can flow. The default model without Contour backs is

ModeDir=1. Before using this model the user should carefully read the SIBERIA User Manual.

We are currently working on extensions to Virtual Earthworks in EAMS-Viewer to automate

the construction of the files necessary to model contour banks.
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4.3.3.4 DTM Parameters

SIBERIA names for Parameters:

1: kx (§3.2.1)

2: ky (§3.2.1)

3: GridXY (§3.2.2)

4: East (§3.2.2)

5: North (§3.2.2)

These are the characteristics of the elevation data used in the simulation. You should

never modify the first two parameters. These tell SIBERIA how big the grid is that being input

to the model. If these are changed SIBERIA will be unable to read the RAW or RST2 file input.

The third parameter gives the resolution of the grid. This also should not be changed

because it can be used within SIBERIA to convert between discharge/unit width to

discharge/node within the model. Thus changing this may lead to incorrect results.

The final two parameters give the south-west corner of the grid. These number are

not currently used in SIBERIA but are used in EAMS-Viewer to georeference the digital maps.

The final three numbers should agree with what you input when you extracted and the gridded

the data earlier.
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4.3.3.5 Channel Parameters

SIBERIA names for Parameters:

1: ModeChannel (§3.2.1)

2: 1/at (§3.2.2)

3: b5 (§3.2.2)

4: m5 (§3.2.2)

5: n5 (§3.2.2)

6: a1 (§3.2.2)

7: DTime (§3.2.2)

8: b6 (§3.2.2)

9: m6 (§3.2.2)

This component of the model controls the ability of SIBERIA to generate channels.

When this model is not used the catchment is considered to be entirely hillslope and erosion

rates are calculated as if the catchment is entirely hillslope.

The operation of this component of SIBERIA and the user is referred to the

SIBERIA manual for a detailed discussion of how this model works.
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4.3.3.6 Tectonic Parameters

SIBERIA names for Parameters:

1: ModeUplift (§3.2.1)

2: FileUplift (§3.2.3)

3: TimeUp (§3.2.1)

4: ZInit (§3.2.2)

5: Notch (§3.2.2)

6: TAmp (§3.2.2)

7: TPeriod (§3.2.2)

8: TPhase (§3.2.2)

For the vast majority of practical applications most users will not use this capability.

For greater detail on how to use this capability see the SIBERIA User Manual.
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4.3.3.7 Advanced Parameters #1

SIBERIA names for Parameters:

1: ModeSoil (§3.2.1)

2: SoilRate (§3.2.2)

3: SoilExp1 (§3.2.2)

4: SoilExp2 (§3.2.2)

5: SMThreshold (§3.2.2)

This model is part of an ongoing research project into the development of soil

profiles using SIBERIA. You should never modify these parameters. You use this model at

your own risk.
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4.3.3.8 Advanced Parameters #2

SIBERIA names for Parameters:

1: ModeI (§3.2.1)

2: ModeSolver (§3.2.1)

3: ModeRandom (§3.2.1)

4: ModeMC (§3.2.1)

5: DirReg (§3.2.1)

6: FactMx (§3.2.2)

7: FRanMn (§3.2.2)

8: YFix (§3.2.2)

9: FRanCV (§3.2.2)

10: b3SDs (§3.2.2)

11: b3SDl (§3.2.2)

12: FranZ (§3.2.2)

13: YHold (§3.2.2)

Most of these parameters control the internal operation of SIBERIA or control very advanced

modes of operation of SIBERIA that should be used with extreme caution. It is unlikely that

you will ever need to modify these parameters in normal day to day applications. Moreover, if

you modify them it is possible that SIBERIA will not run or will give erroneous results.
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Viewer Window showing the File pulldown menu

Viewer Window

Viewer Window showing content region popup menu

5 EAMS Viewer Menu Options

When EAMS-Viewer is

initially started two windows will appear

on the screen.

The 1 st window looks like

the one at the left with a menu bar across

the top. This window is used to control

the application. The menu items are

triggered with the left mouse button.

Below we will refer to this window as

the ‘viewer window’

The 2nd window is a black DOS command window and opens in the background.

Nothing of any importance will appear on this window but do not attempt to close this window

as doing this will kill the application. If this black window gets in the road you can shrink it to

the window bar at the bottom of the screen.

There are two parts to the

viewer window (see left).

The first part is the menu bar

across the top. These menu items are

triggered by use of the left mouse button

and the individual items are explained in

the sections that follow.

The second part is the

content portion of the viewer window

which is the large white section below

the menu bar. If you do anything that triggers some form of output to the screen then this

information appears here. This window can be resized to provide more visible lines of output

and the window can be scrolled up and down using a popup menu in the content portion (see

above). This popup menu is accessed using the right mouse button.

5.1 File Menu

The file menu controls all aspects of

manipulation of files of data. The

individual menu items are explained in

the following sections.
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Viewer Window and the content region after file input

Viewer Window and the content region after file input using

differencing

5.1.1              Open

The open menu item is used to input the

RST file input. If when you ran

SIBERIA you also generated a

corresponding RSU file (see the

SIBERIA manual and the ‘siberia.setup’

file) then Viewer will also input this as

well provided it is the same directory as

the original RST2 file.

The content window shown here is for a

RST2 file (generated in this case by

version 7.08 of SIBERIA) and the Viewer has not found a corresponding RSU file.

5.1.2              Difference

The difference menu item allows

you examine the difference between

two SIBERIA output files. As for

the open menu, if there are

corresponding RSU files they are

also input and differenced.

After selecting this

menu item you will be presented

with two file input dialogs

(corresponding to the 1st and 2nd

files respectively). After input of the

two files the content window will look something like the screen snapshot above.

After inputting the files you will find under the PLAN and SURFACE menu items

two additional datasets. The 1st dataset is simply the first data set input. The 2nd data set is the

first data set minus the second dataset. The menu item for the 2nd data set will have a ‘(-)’ before

the name of the 2nd file to indicate that it is a difference data set and that it is the file above it in

the menu list minus the one in the menu item.

5.1.3             Statistics

This command request statistics for

each data file and is slightly

different from the statistics
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Viewer Window and the content region after statistics output

Viewer Window and the Plan pulldown menu

command that is part of the popup menu in the PLAN windows. It outputs statistics for all of

the states in the nominated file (selected from the dialog on the left that comes up after

requesting this option) over the whole domain. If you wish to get statistics for a region of the

file then you must select statistics from the popup menu in the PLAN window.

A typical set of results from a

statistics request is shown at left.

Note that the statistics are

provided for the region within

the boundaries of the domain.

The ‘no of valid points’ is the

number of points identified to be

within the boundary. In general

the ‘network’ statistics result is

meaningless because it simply

summarises the integer values

for drainage directions (see the SIBERIA manual for an explanation for how this works).

5.1.4              Quit

This command quits the application and closes all currently open windows and files.

5.2 PLAN Menu

This menu controls the display of a

plan of a data set a plan window. The

plan window is the main window in

which data analysis is done and is the

work house of Viewer.

There are two menu items on this

menu and they are discussed below.
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5.2.1              Draw

This menu item allows you to select

the data set that you wish to display on

the screen. Initially when Viewer is

started there are no submenus to this

menu item but each time a file is

opened its data is added to the menu

item as shown at the left.

To select a dataset to be displayed

simply select the data set in this drop

down menu. Aftre selection of this item the plan window will be drawn on the screen using

defaults for the size of the window and the data range. The appearance of this window can

then be manipulated in the plan window (see below).

5.2.2              Overlay

The overlay menu item allows

you to overlay various pieces of

information on top of all existing

plan windows. This overlay is

always positioned on top of

whatever changes occur to the

plan picture of the data. When

the overlay option is selected it is

applied to ALL plan windows.

The data than can be overlayed are

(1) the position of each data point in the domain

(2) the grid that the data is displayed on

(3) the drainage network for the domain.
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DO NOT USE
WINDOWS CLOSE

BUTTON

The Plan Display Window showing its various component

5.2.3             The Plan Window

When initially displayed the plan window will look something like the picture above. There

are three regions in this window that will be discussed in detail in the following sections. In

each of these regions there is a popup menu for modification of the window appearance.

These popup menus are accessed with the right mouse button. The three regions of the

window are

(1) The Content Region: This is the large region in which the data is displayed.

(2) The Colour Bar: The colour is the left hand part of a strip across the bottom of the

window and controls the colours used in the content region.

(3) The Manipulator: This is the set of arrows on the right hand side of the strip on the

bottom of the window. This controls the position of the data in the content region and

allows you move left, right, up and down as well as zoom in and out.

NB: It is important NOT to use the Windows close button (the cross in the top right corner

the window as this will totally quit EAMS-Viewer, not just close the window).
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Content Region with main popup menu visible

Viewer Window with results for a Single Point

Viewer Window with results for a Rectangle, showing

the left and right boundaries of the selection and the data

range.

5.2.4             Plan Window Components: Content Region

The content region of the window is

that region in which the data is

displayed. There is a pop-up menu in

this region (accessed using the right

mouse button) that provides tools for

data analysis. The picture to the left

shows the main popup menu in this

region and we will now discuss the

role of the main menu item here.

In addition you can also inquire the

value of the variable in the content

window by use of the left mouse.

This doesn’t require the pulldown

menu.

Inquire a Single Point: Click with left

mouse button on the node for which

you wish to know the value. The

position and value of that point are

output in the Viewer Window (see

left).

Inquire a Rectangle of Points: You

select a rectangle of points by rubber

banding a box. Simply left mouse

click at one corner of the desired

rectangle and with the mouse held

down drag to the other corner, then

release the mouse. The results for the

rectangle are output in the Viewer

Window (see left). If you wish to

have more precise control of the

rectangle position use the pulldown

menu in the window, which will

allow you to type in the rectangle

coordinates.
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The Data Range dialog

The Viewer Window with the results of Statistics

request. Note that the data range and the number of data

points are also output. Note that the number of ‘valid

data points’ will be less than the number of points you

would calculate from the dimensions of the rectangle if

the rectangle partly lies outside of the boundary of the

landform.

Statistics>

The statistics menu item allows you

more precisely control the region for

which you want to data results than is

possible by using the rubber banding

in the content region.

When you request this option you are

presented with a dialog as on the left.

You may request to analysis the whole

of the region (i.e. click in the radio

button that says ‘All Data’) of a

rectangular subset of a region (i.e.

click in the radio button that says ‘Data

range”). If you want to analyse a

rectangular subset you then need to

specify the minimum and maximum

values for the x and y coordinates (the

units are nodes starting at (1,1) at the

bottom left hand corner). When you

click OK the data will be output to the

Viewer Window (as shown left).

Wether you get the statsistics for all

data sets in the appropriate file or just

those for the window you are

examining depends on what mode is

set in the Options menu in the Viewer

Window.
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Content Region with Viewing popup menu visible

Viewing>

This menu item allows you

input exact values for the

position of the data within the

window. This menu item

performs the same role as the

manipulator but more

precisely.

For each of the menu items

selected a dialog will brought

up in which you input the

required data. The default data

in these dialogs is the current

information for the region.
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Content Region with Select popup menu visible

After Select>Catchment (note that the grey square has

been identified as the catchment outlet because of the use

of Modify Drainage)

Rubber banding during Select>Region

Select>

This menu item allows you select a

portion (called a ‘region’) of the

domain. This region can then be

output to a file so that it may be sued

by SIBERIA to specify regions

within the domain that have different

runoff or erosion properties.

There are 5 options for selecting a

region. They are

(1) Catchment: In this option you can

select an entire catchment from

catchment divide all the way down to

the catchment outlet. Simply click

somewhere inside the catchment you

are interested in. It is generally useful

to have Overlay>Network selected to

make it easier to see which catchment

you are selecting (see the pulldown

menu options in the Viewer window).

You can also select just part of

catchment by using the Modify

Drainage menu item (see below) to

break the drainage paths at your

desired point and then selecting the

catchment either upstream or

downstream of that point. After the

operation the catchment area selected

will be highlighted in white.

(2) Region: In this option you can

select an irregular region by using the

mouse. Click at the first point in the

region and then click at each corner

of the region (a grey line will be

rubber banded while you are moving

the mouse around). To finish the

selection f region double click and

the region will be closed with the last

line being added to meet up with the
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The final result from Select>Region

The result of the selection of by Select>Point

The result of a selection by Select>Downstream Points

first point. At this point a white

irregular region will be overlayed

showing those nodes that have been

selected inside this region. The

original region input will also be

shown.

(3) Single Point: This option allows

you select a single point. Simply

click at or next to the point you wish

to select. You might find it useful

for this option to have

Overlay>Grid or Overlay>Nodes

selected when you do this to allow

you to better identify the point you

want to select.

(4) Downstream Points : This allows

you to select a drainage path

downstream of a selected point. In

this case click on the node at the

upstream end of the drainage path

and all points downstream of this

point will be selected. You might

find it useful for this option to have

Overlay>Network selected when

you do this to allow you to better

identify the point you want to select

(5) Merge Selections: When you

read in region file the selected

region from the region file is kept

separate from any region that you

might already have selected (this

allows us to undo anything that

might already be done). This is why

a file that is read in is shown as grey

instead of white. There are times

when you want to create a region

that is merger of two separate region

files or of a region file and a
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selection on the screen. In this case if you merge selections then all the current selected areas

are merged together so that when you output to a region file everything is output. Otherwise

only those areas that are white are output. After Select>Merge Selections all selected area will

be white.

The figure below exemplifies the process. In step 1 a region has been selected with

the mouse. In between Step1 and 2 this selection has output to a region file (called

        
1. After making Selection 1 2. After saving Selection 1 and clearing the

selection using Select>Reset

        
3. After making Selection 2 4. After reading in region file created at Step 2.

Selection 2 is in white while Selection 1, read

from the region file, is in grey

5. After merging selections.
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Save file dialog for a Selection

‘selection1.rgn’, region files are expected to have the extension ‘.rgn’) and then the active

selection has been cleared with Select>Reset. In Step 3 another selection is made, called

Selection 2. In Step 4 Selection is read in from the region file created between steps 1 and 2.

The active selection (i.e. the one that is used by Viewer if it does operations on selections) is in

white, while the one read in from the file is grey. If read a second file in then it would also be

grey, as well as the original file. In Step 5 these selection have been merged, indicated by the

whole region being white. Now if Viewer does something based on the region it used the two

white areas whereas in Step 4 it would only use the right-most white area and not use the grey

area. For instance, if you output a region file after Step 5 it will use the two areas in white,

whereas in Step it would only output the right-hand area.

In addition to creating selected areas there are a number of menu options in Select. They are

Reset: This erases any active selections

Input from File: This allows you to input a previously saved selection

Save to File: This saves the current active selection, typically in a region file. A region file is

almost identical to a SIBERIA boundary file

with one exception. A SIBERIA boundary

file must have a catchment outlet(s) selected

whereas this is not necessary for a region

file. When you ask to output a selection you

Are presented with a dialog as to the left.

You need to select what type of file to output

(the name must end in .bnd for a SIBERIA

boundary file and .rgn for a region file).

The default directory for the save is the

Program Files directory on the system disk. If this is not where you want it then you will

need to specify the full file path name.
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Content Region with Unselect Popup menu visible

UnSelect>

This menu item is the exact reverse

of the Select menu item. This

allows you to unselect or exclude

points from an already selected

region. Note that you do not have to

do the unselection from the same

window that you did the original

selection in. This allows then to

select based on one or more

characteristics (e.g. elevation) and

then unselect parts of that already

selected region on the basis of some

other characteristics of the data (e.g.

slope)

There are three options on this menu item.

(1) Catchment Outlet: This allows us to unselect an entire catchment by using the mouse to

identify the outlet of the catchment you want to unselect. Simply click on or next to a node

and the catchment upstream of that point will be unselected.

(2) Region: In the same way that you selected a region you mouse around a region and that

region will be unselected.

(3) Input Region File: Read in an already output region file (presumably from a previous

selection operation) and the region in the file will be unselected.
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Plan Window and the Modify Drainage popup menu

Modify Drainage>

This option allows you to

modify the drainage pattern of

the landform. Essentially you

use the mouse to break the

drainage paths so that one node

no longer drains to another node.

This is most useful when you are

selecting a region using the

catchment option. By breaking

the drainage path you are then

able to select a catchment (see

the ‘Select>Catchment’ menu

option) above a given point in

the landform instead having to

select the entire catchment all way down the edge of the boundary of the landform. Note

that in both cases the drainage directions of the landform are permanently modified inside

Viewer but the original file that was input is not affected (i.e. you can always read it into

Viewer again) There are two options on this menu item.
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Drainage network before Drainage Modification

Drainage Network after Drainage Modification of a single point

identified by the small grey square in the centre of picture. Note

that the drainage line down stream of the grey square has

dissappeared.

(1) Catchment Outlet: This option allows you to break the drainage at a single node in the

domain. Simply click at or near the node in question and the node will have its drainage

path broken. Its useful when doing this to have Overlay>Network (from pull down menus in

the Viewer Window) turned on as this will immediately confirm that you have selected the

right point because the blue line linking that node with the one downstream will disappear.

This indicated that the selected point no longer drains into the node that used to be

downstream.
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(2) Multiple Catchment Outlet: In this case you rubberband a line (i.e. press the mouse down

at the start of the line and hold the mouse down while you mouse to where you want the end

of the line to be, then release the mouse). All drainage paths that cross that line will be

broken. As with the Catchment Outlet option above it is useful to have Overlay>Network

turned on when doing this. This option is a useful way to break a large number of drainage

paths simultaneously as, for instance, when you want to select all catchments above some

feature in the landform. This is useful if you want to select all nodes upstream of some

feature (e.g. the edge of the rehabilitated landform) but to one side of a drainage divide

because all you then to do is then select each of the catchments upstream of the breaks. You

could do this with Select>Region but it can often be difficult to follow the catchment divide

accurately even with Overlay>Network turned on.

Drainage network before Drainage Modification

the rubber banded path

Drainage Network after Multiple Drainage Modification (the rubber banded line was from top to bottom in

the middle of the picture). Note that the drainage lines in the centre of picture have dissappeared.
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Virtual Earthworks>

Virtual Earthworks are a set of simple tools to manipulate the shape of the landform. It is

most useful for rehabilitation design. This part of the Viewer package is document in

Section 6. Once triggered it operates relatively independently of the Viewer software.

Refresh Window>

This menu item exists for when you set Manual Refresh in the Viewer Window pulldown

menus. When you have lots of windows open in Viewer the automatic refreshing may

become quite distracting and sometimes (depending on your graphics hardware) quite slow.

In those it is suggested you turn off Automatic Refreshing and use the Refresh Window

option.
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Colour Bar Popup menu.

              
The Colour Selection Dialog. The Range Selection Dialog.

5.2.5             Plan Window Components: Colour Bar

The colour bar controls the colours

used for visualisation, contouring

and the range used to clip the

display of the data (i.e. data

outside the range is clipped to the

display range). Like the other

regions of the window the colour

bar has a popup menu that is

accessed by use of the right mouse

button (see left). The colour bar is

straightforward to use.

To change the range of

the data to be displayed click on

one of the two numbers values

underneath the colour bar. You

will prompted with a dialog to

change one or other of these

minimum and maximum value.

To change the colours

for the top, mid point or bottom

colour click in the appropriate box

above the colour bar. Again you

will prompted with a dialog to

change those values. Alternatively

a range of colour schemes are

provided in the popup menu.

To display all values

below the minimum value as black

select the menu item Low Black>On. To display all values above the maximum value as white

select the menu item High White>On.

Finally to draw pseudo-contours on top of whatever colour scheme you have

adopted select one of the options under Overlay Contours. Sinusoidal provides a number of

cycles of smooth lightening and darkening from the bottom of the data range to the top. Positive

Ramp is a gradual decrease in lightness then a sudden increase followed by another gradual

decrease, etc . Negative Ramp is the opposite of Positive Ramp.
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The Translation popup menu

The Zoom popup menu

5.2.6             Plan Window Components: Manipulator

The manipulator is the small set of arrows in the bottom right hand corner of the window. It

provides control of the position of the drawing within the window.

To move the picture click on the left

arrow, right the right arrow, etc. The increment that

is moved each time can be modified in the popup

menu in the manipulator region (using the right

mouse button) by setting a number for the

Translation Scale factor

To zoom in click in the circle in the

centre of the arrows. The zoom out hold down the

control(ctrl) key while clicking in the circle.  Again

the increment that is zoomed each time you click

can be controlled with the popup menu.

The popup menus also allows you to

return to the original view before any manipulation.

Finally the same effect as clicking in the

arrow keys can be obtained by placing the mouse in the content portion of the window and

clicking on the left, right, up and down cursor buttons on the keyboard. The ‘+’ key zooms in

and ‘-‘ zooms out. Finally if you set the numeric keypad on the buttons ‘4’, ‘8’, ‘6’, and ‘2’ can

be used to move the picture around (note the similarity to a cross of the arrangement of these

four keys).



EAMS 2.00 User Manual 59

Viewer Window and the Surface pulldown menu

Viewer Window and the Surface>Draw menu.

Viewer Window and the Surface>Drape menu.

5.3 SURFACE Menu

This menu controls the display of a

plan of a data set a plan window. The

plan window is the main window in

which data analysis is done and is the

work house of Viewer.

There are three menu items on this

menu and they are discussed below.

5.3.1              Draw

This menu item allows you to select

the data set that you wish to display

on the screen. Initially when Viewer

is started there are no submenus to

this menu item but each time a file is

opened its data is added to the menu

item as shown at the left.

To select a dataset to be displayed

simply select the data set in this drop

down menu. After selection of this

item the surface window will be drawn on the screen using defaults for the size of the

window and the data range. The appearance of this window can then be manipulated in the

surface window using the popup menu options(see below).

5.3.2              Drape

This menu item allows you to select

the data set that you wish to display

on the screen. This date set is then

draped over the elevations of the

landform. Initially when Viewer is

started there are no submenus to this

menu item but each time a file is

opened its data is added to the menu

item as shown at the left.

To select a dataset to be displayed simply select the data set in this drop down menu. After
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Viewer Window and the Surface>Overlay menu.

selection of this item the surface window will be drawn on the screen using defaults for the

size of the window and the data range. The appearance of this window can then be

manipulated in the surface window using the popup menu options (see below).

5.3.3              Overlay

The overlay menu item allows you to

overlay various pieces of information on

top of all existing plan windows. This

overlay is always positioned on top of

whatever changes occur to the plan

picture of the data. When the overlay

option is selected it is applied to ALL

plan windows.

The data than can be overlayed are

(1) the position of each data point in the

domain

(2) the grid that the data is displayed on

(3) the drainage network for the domain.
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The default view when the SURFACE window

opens

The surface after it is rotated to provide a good

viewing angle and lighting is turned on.

5.3.4             Surface Win        dow Components: Content Portion

The content region of the window is that

region in which the data is displayed. There

is a pop-up menu in this region (accessed

using the right mouse button) that provides

tools for data manipulation. The main

purpose of the Surface window is not data

analysis but data visualisation. For data

analysis you should use the PLAN window.

Initially by default the view of

the landform is shown from above and

looks very similar to the plan window.

However, by rotating the landform (see the

Manipulator section below) and turning on

the lighting the three-dimensional viewing

of this landform becomes clear (see left).

There are a number of popup

menu options from the content part of the

window and we explain them now.

To be able to set repeatable

display characteristics from window to

window there is an easy way to save the

light position. See the discussion of the

Viewing>Save Macro popup menu item for

this capability.
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The Viewing popup menu

Viewing>

This menu controls how the data are

displayed.

The first four options (‘Home

View’, ‘View All’, Get Viewing Position’,

and ‘Set Viewing Position’), control the

orientation of the data. Less precise, but

easier to use, orientation of the data is also

available through the manipulator portion

of the window (see below).

The macro options allow the

saving of the current format of the picture

so it may used again at a later data, or for

another surface window. When ‘Save

Macro’ is selected the current setting for the window are saved to a file. These include (1)

colour scheme, (2) vertical exaggeration, (3) orientation of the data, (4) lighting and rendering

options. When ‘Apply macro’ is selected the saved settings are applied to the current surface

window. Only one set of settings may be saved at any one time.

The ‘Vertical Exaggeration’ setting allows you to control how vertically

exaggerated the surface is. Typically if no exaggeration is used the surface will look flat

because the vertical dimension is typically much less than the horizontal dimensions. Viewer

initially selects a reasonable exaggeration based on the data ranges and use will need to change

those with this menu item.
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Rendering popup menu.

Rendering>

Rendering controls how the surface is

displayed. There are a variety of options.

The two Rendering options

require lighting. A default position is set

by Viewer initially and the position of this

light can then manipulated by the Lighting

popup menu.

The other rendering options do

not use lighting so the Lighting options

have no effect on these.

To be able to set repeatable

rendering from window to window there

is an easy way to save the light position.

See the discussion of the Viewing>Save

Macro popup menu item for this

capability.
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The Surface lighting popup menu

Lighting>

The lighting options are not active

until one of Rendering options that

require lighting are selected. By

default when the surface window is

displayed lighting is not activated.

In the default position

(see left) the left edge is the western

edge, the right edge the eastern edge,

etc. The lighting positions based on

the time of day are consistent with

this orientation.

The backlight/frontlight

options correspond roughly to winter

position of the sun for the Northern

and Southern Hemispheres.

The ‘Get Lighting Position’ option puts up a dialog with the exact coordinates of the

sun, while the ‘Set Lighting Position …” option allows the input of the exact lighting position.

To be able to set repeatable lighting from window to window, however, there is an

easy way to save the light position. See the discussion of the Viewing>Save Macro popup menu

item for this capability.
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Colour Bar Popup menu.

              
The Colour Selection Dialog. The Range Selection Dialog.

5.3.5             Surface Window Components: Colour Bar

The colour bar controls the colours

used for visualisation, contouring

and the range used to clip the

display of the data (i.e. data

outside the range is clipped to the

display range). Like the other

regions of the window the colour

bar has a popup menu that is

accessed by use of the right mouse

button (see left). The colour bar is

straightforward to use.

To change the range of

the data to be displayed click on

one of the two numbers values

underneath the colour bar. You

will prompted with a dialog to

change one or other of these

minimum and maximum value.

To change the colours

for the top, mid point or bottom

colour click in the appropriate box

above the colour bar. Again you

will prompted with a dialog to

change those values. Alternatively

a range of colour schemes are

provided in the popup menu.

To display all values

below the minimum value as black

select the menu item Low Black>On. To display all values above the maximum value as white

select the menu item High White>On.

Finally to draw pseudo-contours on top of whatever colour scheme you have

adopted select one of the options under Overlay Contours. Sinusoidal provides a number of

cycles of smooth lightening and darkening from the bottom of the data range to the top. Positive

Ramp is a gradual decrease in lightness then a sudden increase followed by another gradual

decrease, etc . Negative Ramp is the opposite of Positive Ramp.
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The Translation popup menu

The Zoom popup menu

5.3.6             Surface Window Components: Manipulator

The manipulator is the small set of arrows in the bottom right hand corner of the window. It

provides control of the position of the drawing within the window.

To move the picture click on the left

arrow, right the right arrow, etc. To rotate the

picture hold the control key while you press on the

arrows. The increment that is moved each time can

be modified in the popup menu in the manipulator

region (using the right mouse button) by setting a

number for the Translation Scale factor

To zoom in click in the circle in the

centre of the arrows. The zoom out hold down the

control(ctrl) key while clicking in the circle.  Again

the increment that is zoomed each time you click

can be controlled with the popup menu.

The popup menus also allows you to

return to the original view before any manipulation.

Finally by placing the mouse in the content portion of the window and clicking on

the left, right, up and down cursor buttons on the keyboard the surface can be rotated. The ‘+’

key zooms in and ‘-‘ zooms out. Finally if you set the numeric keypad on the buttons ‘4’, ‘8’,

‘6’, and ‘2’ can be used to rotate the picture around (note the similarity to a cross of the

arrangement of these four keys). In addition, the keys ‘7’ and ‘9’ can be used to tilt the picture.
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5.4 OPTIONS Menu

The options menu allows control over various

default ways that Viewer operates.

5.4.1            Input Options

This controls what happens when you input the data files. You may swap the data north-

south, or east-west. This option is ONLY active when you input a file so if you input and

then change this option all previously input files are unaffected but all subsequent file are.

5.4.2             Selection Visibility

When yopu make selection in a PLAN window this option determines what other windows

this selection appears. By default only the window in which you do the selection displays

the selection but can also (1) have it displayed in all other PLAN windows from the same

file, and (2) have it displayed in any corresponding SURFACE windows as well.

5.4.3            Inquiry        outputs

When you inquire a point this option determines whether you only get the data from that

window in which you inquire or whether you get data for data sets from the corresponding

file.

5.4.4              Window Refresh

Be default all windows refresh automatically when they need to be updated (when the data

in them changes, when that window is brought to the front for some reason, etc). If you have

a large number of windows open this behaviour may become quite tiresome. In this case

you can set the windows to manual refresh and use the popup menu options in the PLAN

and SURFACE display windows to update the windows manually when you need to.
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APPENDICES

Appendix A: Revision History

Version 1 (1998-2002)

Version 1 was developed for mine site rehabilitation applications as part of the Queensland

Coal Association “Post-Mining Landscapes” project. It involved the development of an

interface to a series of pre-existing codes as well as the development of a database of

parameters for erosion prediction based on field data collected in this project. This version of

the software was not widely distributed beyond research colleagues. It was also restricted to

running on Windows 95 and 98 because of limitations in the graphics software used to develop

the GUI interface.

Version 2 (2002-date)

A major upgrade for EAMS. This involved rewriting the code to use a Fortran 90 interface to

the OpenGL graphics and other support libraries. This allowed the support of Windows 2000,

XP and ME.

• 2.00: Implementation of F90 interface and updating to Windows 2000/XP/ME.

• 2.01: Maintenance upgrade. Numerous small bug fixes in Moscow. Viewer unchanged.


